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Disclaimer
Interactive Individual Identification
System - Pattern version 4.0
I3S Pattern is free software; you can redistribute it and/or modify it under the terms of the
GNU General Public License, version 2 or any later version published by the Free
Software Foundation.
This manual is released under the terms of the GNU Free Documentation License,
version 1.1 or any later version published by the Free Software Foundation.
This program is distributed in the hope that it will be useful, but
WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for
more details.
You should have received a copy of the GNU General Public License and GNU Free
Documentation License along with the distribution (COPYING GPL v2.txt and
COPYING.DOC.txt) If one of these files is missing, write to the Free Software
Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA.
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1 Introduction to I3S Pattern
1.1

3

What is I S Pattern?

I3S is an acronym of Interactive Individual Identification System. I3S Pattern is an extension of the I3S
system using any existing natural pattern on the animal’s body. This name explains most of I3S
Pattern’s functionality. First, we will focus on the interactive part. I3S Pattern requires user interaction
and is meant to support and not to replace the researcher. Initially, you have to point out the relevant
part of the pattern of the unknown individual animal. I3S Pattern has an automatic key point extraction
algorithm which generates a unique fingerprint for each image. In the next step, I3S Pattern assists
you in the tedious task of matching animals for identification purposes. It automatically matches an
annotated image of an unknown animal with all annotated images in the identification database and
shows a ranked list of images. However, you will always be responsible for making the final match
between the unknown image and an image from the identification database. Please note that we
distinguish between your database with all images taken and the identification database. The
identification database contains only the best images of known individuals and preferably 3 to 5 of
each individual.
I3S Pattern is the fourth release in a series of related software tools. The first was I3S (now referred to
as I3S Classic). This package is based on annotation of the spot centers and is used for animals with
lots of similarly shaped spots such as whale sharks. The second package was named I3S Manta
(now I3S Spot) . I3S Spot focuses on animals with less spots and more variation. Instead of
annotating the centers only, spots are annotated by the closest fitting ellipse around each spot, in this
way taking spot size and shape into account. The third package was I3S Contour, which used the
contour of e.g. flukes for identification.
We refer in the remainder of this manual to I3S Pattern as I3S.

1.2

The algorithm

1.2.1 Key point extraction
To help recognize individual characteristics I3S automatically extracts all key points within a region of
interest indicated by the user. The region of interest is the area in the image used for identification.
Each key point has a size and location. The image should be taken ideally perpendicular to the line
of sight and no more than 30 degrees off that line. The algorithm for automatic key point extraction
uses the OpenCV (http://opencv.willowgarage.com/wiki/) implementation of the SURF features
(http://www.vision.ee.ethz.ch/~surf/).
Once the key points are extracted, the collection of key points is stored in what is called a ‘fingerprint
file’. You recognize these files by the extension .fgp. In the identification step, the resulting key
point pattern is matched with the patterns of all the known animals in the identification database.

1.2.2 The reference points
To be able to correct for differences in viewing angle, rotation and scaling, the user is always
required to point out three fixed reference points. The reference points should satisfy the following
requirements:

6

3

I S Pattern Manual, v4.0.2 July 2014

1. Their exact location is consistently and clearly distinguishable.
2. Visible in all images.
3. The triangle made up by the three reference points should cover most of the region of interest
used for identification. Ideally the triangle should have angles of 60 degrees. In most cases this
will not be possible, but you should try to get as close as possible for optimal results.
Figure 1-1 shows the reference points advised for a turtle in blue. The edge of the beak, the edge of
the eye area, and the edge of the most outer scale are used as reference. Do not mix-up these
reference points as this will inhibit proper recognition. See section 4.1.3 if you want to change the
names of the reference points.
Each new species will require careful selection of the three reference points as this is critical for
performance of I3S. If you want to use I3S on a new species you are advised to consult the I3S team
for support at i3s [at] reijns.com.

Figure 1-1: Turtle with reference points and automatically
extracted key points. (Image source: PWF)

1.2.3 Key point comparison
With the reference points selected it is now possible to correct for rotation and scaling and compare
two images in roughly the same 2D recognition space or coordinate system. A comparison of two
images comes down to finding corresponding key point pairs in the above-mentioned coordinate
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system. In the current implementation a key point pair is accepted as a good match if the nearest
other candidate is at sufficient distance from the current match. Further, the key point sizes should
be sufficiently similar. Figure 1-2 shows the (centers of the) key points of two different images of the
same turtle in this coordinate system. The red circles denote the key points of the first image while
the blue circles represent the key points of the second image. The green lines indicate whether two
key points are considered a matching pair. From these pairs a distance metric is calculated to be
able to rank each image in the database. The current metric is the sum of the distances between
each key point pair, divided by the square of the number of key point pairs. When comparing two
fingerprints I3S may generate thousands of potential ways to map the two fingerprints onto each
other. Only the best mapping is used. Further, differences in size will also affect the final score. The
larger the differences in sizes the higher the score (where a lower score indicates a better match).

Figure 1-2: Comparison of the key points from two images.

Obviously, there are some limitations to this approach. 2D linear transformations work best for 2D
linear animals, which do not exist. However, this approach has proven to be effective if some
constraints are considered.
For details on the original algorithm, you are referred to our paper: A computer-aided program for
pattern-matching natural marks on the spotted raggedtooth shark Carcharias taurus (Rafinesque,
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1810), A.M Van Tienhoven, J.E. den Hartog, R.A. Reijns & V.M. Peddemors, Journal of Applied
Ecology 44, 273–280 (2007). For specific details on the implementation, please contact the I3S team
by email or consult the source code delivered with the distribution.

1.3

I3S Version numbering

Version numbers are related to I3S Classic , I3S Manta and I3S Contour. Even though I3S Pattern is
new, the current version is version 4.0. Most of the underlying software for metadata and user
interfacing is an update of existing software from I3S Contour v3.0, hence the v4.0 version of I3S
Pattern.

1.4

I3S Updates

I3S will automatically check for updates and new releases. This feature will be implemented in all I 3S
software packages in version 3.0 and higher. Every 30 days, upon start-up of I3S, it will check for
updates. If an update is available, it will ask you if it should download and install a new version. After
each update I3S will ask if you want to see the release notes on the website.

Figure 1-3 Update check.

Please note that downloading and installing updates only works in Windows Vista or Windows 7 if
User Account Control is turned off and if you have sufficient rights. UAC prevents I3S to copy files to
protected locations such as C:\Program Files even if you have administrator rights. You can
manually set this parameter via the Control Panel of your computer.

1.5

Reading this document

In this document all file names, directory names and shell commands are written using the font
Courier New. All names relating to a part of the I3S user interface, such as button names or menu
options, are boxed. If a message is particularly important the margin will show a large red boxed
exclamation mark.

1.6

Bug reports, comments and requests

Please send all bugs, comments and questions to i3s [at] reijns.com. In case of a bug, describe
clearly how we can reproduce the bug ourselves. If possible provide us with all relevant data such as
images and fgp-files. We will always treat your data as confidential. Data will not be distributed to
others without your explicit consent.
An error log file will be written in the _ErrorLogs directory in your database directory when internal
errors are reported by the software. This file (or files) can also be sent to the I3S team along with any
bug report.
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2 Installation of I3S Pattern
2.1

System requirements

This version of I3S requires a Windows 32-bits or 64-bits operation system (XP/Vista/Windows7).
Windows 8 probably works as well, but we have not specifically tested this operating system. The
software is developed using Java 1.6/1.7 and C++ (MS Visual C++ 2010). Both Java and most of the
C++ code are platform independent and it should therefore be relatively simple to port it to other
platforms such as Linux or Mac OS. OpenCV is available under all common platforms.
Hardware requirements are at least 2GB of memory (preferably 3 GB or more), and a 2 GHz CPU or
faster. Increase of the identification database to hundreds of images will increase the preferred
requirements on CPU speed but will have a limited impact on the memory requirements. Comparison
is linear in computational requirements, i.e. an identification database with twice the number of
individuals will require twice the time to compare with.

2.2

Software and data requirements

Because the main program is developed in Java, the Java Run-time Environment (JRE) is required.
This distribution will only work with a 32-bits JRE version 1.7.0 or higher! The JRE 7 (or higher)
can be downloaded for free from the Java website (http://www.java.com/en/download/manual.jsp) or
Oracle website (http://www.oracle.com/technetwork/java/javase/downloads/java-se-jre-7-download432155.html and download version Windows x586 Offline).
Note: I3S currently only works with the 32-bits version of the JRE. I3S has been developed on a 64bits version of Windows 7, however with a 32 bits JRE. If a 64-bit JRE is used, I3S will report an error
at start-up of the program.
I3S supports both JPEG (extension .jpg) and GIF (extension .gif) images. Support of other image
types is currently note foreseen as all known digital cameras can store images as JPEG.

2.3

Installation

Make sure you have administrator rights and turn User Account Control (UAC) off. UAC prevents the
proper installation of the Windows environment variables.
Run the file I3SP_v4.0_Setup.exe. If your current Java version is not sufficient you will be notified
and installation terminates. It is required to install the Java Runtime Environment 1.7.0 (or higher)
first.
Apart from some information about the GNU-license, the installation consists of the following steps:
1. Choosing the home directory where to install the program. Default will be in the directory
C:\Program Files (x86)\I3SP.
2. Choosing whether you want to store an example data directory with image and fingerprint files.
3. You can indicate if you want I3S to create a folder in the Start menu folder.
4. Finally, you can select some additional tasks:
a. Creating a desktop item.
b. Copy tutorial examples in the data directory.
c. Copy the source code. Only if you are interested in using or changing the source code
you need to check this item.
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5. If you selected to copy the tutorial images, you will be asked for the location. Please do not store
the data in the C:\Program Files (x86)directory or one of its subdirectories as this may
result in errors while using I3S. Choose another location such as C:\MyData.
Because an environment variable has been added you are asked if you want to restart the computer
now or later. I3S will not work properly until you restart the computer or logout and login again.
If you want to install I3S under another account, this is possible. At start-up the application will search
for the I3SP_INSTALL environment variable which has as value the directory where I3S is installed.
The default location is C:\Program Files (x86)\I3SP. The installer creates this variable in the
HKEY_LOCAL_MACHINE section of the registry which means that it is available for all users. If this
variable is not found, the application terminates. At the first start-up by another user just select an
existing database or create a new database.

2.4

Norton security alert

After starting I3S you may get an alert from Norton Anti-Virus that it has detected malware. Typically it
will mention that it has found a threat called “Suspicious.Cloud.7.EP”. This is absolutely a false
alarm. If you google on “Norton suspicious cloud false alarm” you will find many hits about other
false alarms. Norton says on their forum the following about this alert:
“Suspicious.Cloud.7.F is one of our heuristic detections. What this means is it's not a true
virus, but rather one of our technologies that tries to detect new (aka "zero-day") threats. It
looks at a number of attributes and behaviours that we've identified as common in existing
threats.”

!

The only way to solve this annoying issue is to tell the Norton application to restore the file and
ignore this file in future scans. Norton has given false alarms on openCV dll’s and i3ssurf.dll.

2.5

Uninstall

You can uninstall I3S in two simple steps:
1. Uninstall I3S, using the entry in the start menu folder.

Figure 2-1 Uninstall via start menu.

2. Optionally you can also uninstall the Java Runtime Environment (JRE). In general it is not a good
idea to uninstall JRE without replacing it for a newer version because other programs may
depend on it. However, if you still want to uninstall JRE use the standard procedure: Select
Programs and Features in the Control Panel. Then select the appropriate item from the list and
click on the Add/Remove button.
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2.6

Quick introduction with video tutorials

Examples are shown in our instruction videos. These video tutorials are available online at YouTube.
Search in YouTube for “I3S channel”. The links to these videos are also available at the website and
via the Help menu. Many of the videos for I3S Classic and I3S Spot apply as well to I3S Pattern. Only
the annotation is different, but searching, defining metadata, etc. is identical for all versions.
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3 Data management
3.1

Introduction

3

I S compares unknown images with an identification database consisting of a collection of imagefingerprint pairs. In this document, with the term ‘identification database’ we mean: a structured
directory containing the collection of all known images used for reference by I3S. Possibly you will
have another database or collection of either known or unknown images, but that is considered an
entirely different database.
A fingerprint file containing all information added in the annotation process accompanies each image
file. Always treat these images as an inseparable pair. If you move one of the files manually to
another directory you should always move the other file along.
Earlier versions of I3S only allowed one identification database. At installation the user had to select a
specific directory where the data was stored. Multiple identification databases (either other types of
animals or other locations) where not supported and resulted in the need to rename and swap
database directories.
I3S Pattern v4.0 allows you as many identification databases you need. The locations of data
directories are stored at an individual level (specific: in the registry in HKEY_CURRENT_USER), so it is
possible to have multiple users using the same pc or laptop and manage their own databases as well
as manage shared databases.
All database management is found under the menu item Database, see §4.1.3 for details on their
use.

I3S management tools

3.2

I3S offers the following tools for data management:
1.

Search in database

Compare an annotated image against the entire identification
database and show a ranked list of results. The lower the score,
the better the match.

2.

Insert in database

Add an annotated image to the identification database. Either add
it to an existing individual or insert it as the first image of a new
individual.

3.

Reload database

In case you have manually added or removed files to the
identification database directory you can reload the current
database to incorporate the changes.

4.

Change database

Load another database from the list of known databases.

5.

New database

Start a new identification database and add it to the list of known
databases.

6.

Rename database

Rename an existing database directory.
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7.

Edit database list

Remove a directory from the list of known identification databases
or add a directory. The latter is used to add an existing
identification database.

8.

Edit metadata

Edit the metadata structure of the current identification database.

9.

Batch compare

If you have a large batch of new photos, e.g. collected at a field
trip, and you do not want to wait for the time to compare each
annotated photo against the database, this option is useful. Just
put all annotated photos in a single directory and let I3S process
all at once. You can read in the results and process the data
without waiting for comparison later.

10. Process batch results

3.3

Further, if you want to compare two databases, e.g. to establish
whether individuals migrate between locations, batch comparison
allows you to find the best matches with almost no manual
interaction. The results are written to an MS Excel readable csv
file.
Process the results in the file resulting from batch compare. For
each compared image a search window with the results is shown.

The database directory

All data in an identification database is structured by means of a directory tree. Images are stored in
a separate subdirectory for each individual in the identification database. Each image is described by
its pattern(s) and by means of metadata fields stored in the fingerprint file with extension .fgp. In
older versions of I3S, the sex and various views where stored by means of subdirectories under the
subdirectory for the individual. Starting with v3.0, sex and views can be covered by the metadata
structure. You are however required to define this yourself.
The top-level directory of an identification database contains for all known individuals a
corresponding directory, the file metadata.xml, a directory named _ErrorLogs for error reports by
the software, and an optional directory _SearchResults with the outcome of the various searches
and evaluations.
For example:
Directory
C:\I3S\TurtleData

Description
Top-level directory. It contains directories for the individuals
Jimmy, Ronald, George and Bill and the directory
_ErrorLogs.

C:\I3S\TurtleData\Jimmy

This subdirectory contains image and fingerprint files
Jimmy001.jpg, Jimmy001.fgp, Jimmy002.jpg,
Jimmy002.fgp.

C:\I3S\TurtleData\Ronald

This subdirectory contains image and fingerprint files
Ronald.jpg, Ronald.fgp, Ronald2.jpg,
Ronald2.fgp, DSC_00261.jpg and DSC_00261.fgp.

The subdirectories for individuals should only contain image files and fingerprint files (extension
.fgp). Other file types are ignored. The image files should be of type JPEG (extension .jpg or
.jpeg) or GIF (extension .gif). Each fingerprint file corresponds with the identically named image
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file (apart from the extension). A fingerprint file contains all the pattern and extra information of the
corresponding image file. The sample identification database provided with the distribution contains
several individual turtles (i.e. subdirectories).

!

Do not add extra directory levels as these will not be parsed!! An example of a directory
which contents will be ignored:
C:\I3S\TurtleData\Ronald\Field trip 2013\

At start-up, I3S looks up the list of known databases. In case the list contains only one, this database
is loaded directly. If the list is empty, you have to create a new identification database first or select
an existing database with a browser. In case the list contains more than one, you are asked to select
a database from a list. After selection, the application starts to parse all the fingerprint files in the
corresponding individual subdirectories. All fingerprint files are stored in memory for quick future
reference during execution of search tasks. Since the fingerprint files are quite small (usually a few
kilobytes) the memory use of the database will be limited.

3.4

Metadata

Each identification database has its own metadata definition. For example it is possible to define
metadata fields to indicate length, size, sex, scars, or whatever you want to define for an individual.
When searching the identification database, it is possible to search on the metadata as well. The
exact metadata definition is stored in the file metadata.xml stored at the top of a database
directory. It is strongly advised not to edit this file manually but to use the graphical interface provided
by I3S for this purpose.
I3S currently supports four types of metadata fields: number, smallmediumlarge, yesno and
Custom. The number format will accept any number such as 0, 12, 4.2 and -5. The type
smallmediumlarge is a variable with three possible values (small, medium and large). Analogous,
the yesno type is a Boolean variable with values yes or no. Custom lets you define a discrete and
limited set of values yourself.

3.5

Error checking on the database

If you manually change the database, e.g. by moving around files or directories, you might introduce
errors. I3S will check for some errors when parsing the database. The checks performed by I3S are:
1. Does each fingerprint file has a corresponding image file in the same directory? This error
typically occurs if you move the image file but forget the fingerprint file or vice versa.
2. Are there subdirectories within individual directories? A warning is generated that the
contents of these directories are not parsed.
If there are errors found a pop-up window is generated. A description of all problems found is written
to the file db_errors.txt in the _ErrorLogs directory of the database.
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4 The I3S user interface
This chapter will address the possibilities of the I3S user interface. First, the menu bar and toolbar are
described. Next, the interaction with the annotation panel is discussed.

4.1

The menu bar

3

I S offers a standard Windows look & feel menu-based interface to perform most operations. In the
paragraphs below, the six menu items will be explained. An overview of the title and menu bar is
shown in Figure 4-1. The title shows the application name version and some details about the
database: name, type and between brackets the number of fingerprints and individuals in the
database.

3

Figure 4-1: The I S menu bar.

4.1.1 The File menu
This is the main I3S menu. Figure 4-2 shows the various operations, which are discussed below:

Figure 4-2: the file menu.



Open image (shortcut CTRL+O). It will open a window to choose an image file. The supported
image types are JPEG and GIF. The starting directory will be the top level directory of the
selected database. If an image file has a corresponding fingerprint file (i.e. the same name but
extension .fgp) a turtle logo is shown, a standard image logo otherwise. The logos are shown
below:
(with .fgp)

(without .fgp)



Save fingerprint (shortcut CTRL+S). If you have annotated an image this operation will write a
fingerprint file in the same directory as the corresponding image together with any metadata.
Apart from the extension, which is .fgp, the name will be identical to the name of the image file.



Close image. It closes the image in the main window. If you have unsaved data I3S will prompt
you whether you want to save the data first.



Print image (shortcut CTRL+P). It will print the current image including comments (see §4.2).
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Exit (shortcut CTRL+X). This operation will close all windows. In case of unsaved data I3S will
prompt you whether you want to save the data first.

Figure 4-3: The edit menu.

4.1.2 The Edit Menu


Undo and Redo are completely analogous to standard Windows functionality. The last 500 edit
actions are kept in memory (Shortcuts: CTRL+Z and CTRL+R).

Figure 4-4: The database menu.

4.1.3 The Database menu


Search in database will compare the current image with the rest of the identification database.
See Chapter 5 for details.



Insert in database In case of a loaded and annotated image, selecting this operation will allow
you to add a new animal (i.e. a new subdirectory) to the identification database. This operation
pops up a new window first that will prompt you for the name of the new animal. Selection of the
checkbox Rename file will allow you to change the name of the image. By pressing Ok the image
and its fingerprint file are copied (not moved) to the appropriate directory in the identification
database. The figure below shows an example. If the file has been renamed, you are asked
whether the original file needs to be renamed as well.
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Figure 4-5: Insertion in the identification database.



Reload database If the identification database has been changed, i.e. fingerprint files have been
manually added or removed using e.g. Windows explorer, this operation will reload the entire
database. You do not have to call this operation after insertion of a new animal in the
identification database. In this case, I3S will reload the database automatically.

Figure 4-6: Changing the database.



Change database If you have multiple identification databases it is possible to load another
identification database without exiting the application. This menu option will offer you a list to
choose the database. Choosing the current database is identical to Reload database. Before
changing the database, open files are closed and/or you are asked whether to save first.



New database If you want to create a new identification database choose this menu option. First,
you are asked to select a new directory, either by typing it in at the text field Folder name or
selecting the Create new folder button. Figure 4-7 shows the window. When you nevertheless
choose an existing directory, the application will ask to create a new directory within the chosen
one. After selecting a new directory, you are offered the window shown in Figure 4-8. Use this
window to specify the database name. Type in a concise name as it is also shown in the top of
the main application window. You can also change the description of the reference points.
Further, it is possible to add a number of metadata fields to the identification database.



Rename database This option allows you to rename the directory of an existing database. First,
you are asked to select an existing database, and then to type in the new name. Only letters,
digits and spaces are allowed. After renaming, you are asked whether you want to change to this
database.
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Figure 4-7: The first step in creating a new database, directory selection.

Figure 4-8: Setting-up the database (non-expert mode).

Figure 4-9: The window to edit the database list.
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1
2

3

4

5

6

Figure 4-10: The window to edit the metadata (expert mode).



Edit database list If you want to remove an old database from the list of known databases or
add an existing database directory you can use this option. Figure 4-9 shows the

20

3

I S Pattern Manual, v4.0.2 July 2014

corresponding window. Remove deletes the selected directory from the list but it leaves the
files in the map untouched. Add lets you select an existing directory and adds it to the list
without checking whether it is a valid identification database directory (this will happen when
the database is actually loaded).


Edit metadata This option allows to edit the metadata fields for the current database. Figure
4-10 shows the window.
The red numbers 1 to 6 indicate some important aspects of this window:
1. The field database name defines the name which is shown in the title of the application.
Press the button
to alter the name. When editing a field, it is not possible to select
other buttons, except Cancel or again to save the result.
2. Names of the three reference points.
3. The expert settings are only available in “expert mode” (see also paragraph 4.1.5). The
will show a pop-up window explaining each variable. These variables are used for fine
tuning the key point extraction and recognition algorithms. You are also referred to
paragraph 6.6. Editing some of the variables will require automatically redoing the key
point extraction. I3S will warn you when this is required.
4. Use the left column of buttons to edit the names of the metadata elements.
5. Press the button to remove the field.
6. Press the button
to edit the names of the custom field type. This button is only
available for type custom as only this type allows you to define a list of possible values,
as is shown for type ‘sex’. When pressing this button the window is enlarged to show the
fields to edit the possible values as shown above. All other elements are greyed out,
except for Cancel and the buttons to edit the fields for the custom element. The minimum
number of values must be two, the maximum is limited to 10. Close editor stores the list
of values (if valid) and returns the window to the previous state.



Batch compare. With this option you can compare a directory with annotated images directly
with the identification database. This feature might be useful if you have a large batch of new
photos, e.g. collected at a field trip, and you do not want to wait for the time to compare each
annotated photo against the database. Another application is to compare two databases to
determine whether there is overlap in individuals to establish migration patterns.
The results are written to an MS Excel readable csv file in the _SearchResults directory of
the current reference database. After selecting Batch compare the window shown in Figure
4-11 pops up. Choose the directory with your annotated new data and I3S will start with
comparing each photo against the database. A progress bar keeps track about the time still
required. After finalization a message is shown where the data is written. Use the options
menu to specify how many of the best matching results are written to the batch results file.



Process batch results. This menu item allows you to process the results from the batch
compare. Each compared image pops-up together with a standard search result window
(paragraph 5.2).
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Figure 4-11: The window to choose the batch directory (top) and the message
confirming the export of all results to the csv file.

4.1.4 The Tools menu  Option results
Options results will pop-up the left window shown in Figure 4-12.
The first part Logging results of the left options window concerns the automated logging of the
searches performed. If logging is on, the outcome of each search will be written to a file in the
database directory (subdirectory _SearchResults).
The naming of the file is SearchResults__<date>_<time>.log. For example, a search on the
second of July 2013, at the time of 17:22:10 will be written to the file named
SearchResults__20130702_172210.log. The content of the log file is identical to the results in
the search results window. Each line contains a filename and the score separated by tabs. Excel can
process this format.
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Figure 4-12: The two option windows.

The second part File or folder in results window will determine whether the results window will show
the last directory of a matching file, or the filename itself. If you choose the filename, please make
sure each filename identifies the individual by name or code.
The third part All or best individual match is used to choose between showing all matching files in the
database or just only the best file from an individual directory.
The fourth part Show results can be used to indicate whether you are interested in the top 50 of best
matches or the entire identification database. This choice will affect both the logging and the search
results window.
Finally, Number of batch results determines how many matches are shown when batch processing.
For example, each time an unknown fingerprint from the batch directory is compared against the
database only the top number of matches is stored.
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4.1.5 The Tools menu  Options general
Options general will pop-up the right window shown in Figure 4-12.
The first part allows you to choose whether you want to get a warning when you drag your mouse
during pattern annotation. I3S requires you to keep the mouse completely still when clicking a point
on the pattern. If you have once chosen never to be bothered ever again you can correct this here.
The second part determines whether I3S is in expert mode or not. When in expert mode, the expert
menu is shown, while editing the metadata shows more options.
The third part allows you to choose the interaction with respect to updates. When choosing
Automatically check for updates the software will check periodically without interaction. Only when an
update is found you will be asked whether you want to install. Ask to check for updates will make
sure I3S gets permission before an update check. Never check for updates will make sure I3S never
bothers you about updates, unless you manually choose Check for updates from the help menu.
The fourth part named Color settings allows you to select which colors to use for the annotation
elements. This can be particularly helpful if the species under study happens to show colors similar
to the default colors used or if you are color blind.
The final part named Number of threads to use determines how much I3S may use of the parallel
processing capabilities of your computer. Default is 1 thread. If you increase this number, recognition
speed will increase as well, however, other tasks carried out in parallel may also become slower (e.g.
word processing, Excel, etc.). Experiments indicate a maximum speed-up of 3 compared to a single
thread (see §6.2 for details). Any time you can set this level to the desired value.

Figure 4-13: The expert menu.

4.1.6 The expert menu
This menu item is only available when expert mode is chosen with the Options general menu under
Tools. See also the previous paragraph. This menu offers four options:
1. Simple evaluation.
2. Elaborate evaluation.
3. Redo database.
4. Redo individual.

!

If you have multiple regions of interest per individual, e.g. left and right side photos of the same
individual, make sure to put them in different directories before doing the evaluation. For example,
make two different directories for Turtle73: Turtle73_Left and Turtle73_Right. Otherwise, the
evaluation tool will count mismatches between right side photos and left side photos incorrectly as
errors (the evaluation tool does not consider the metadata).
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Simple evaluation
This option is used to get an indication how good the various instances of the same individual match
with each other, and whether I3S can be used for matching a certain species. All fingerprints in the
database are compared with all other fingerprints. If a match between two instances of the same
individual yields a score outside the top 10 of best matches this is logged. After the entire database is
matched with itself, an overview is produced which may look like this:
Simple evaluation results
# intra individual comparisons: 210

Accumulated ranking score:

1218

Best possible (ideal)

273

score:

Evaluation took 13 seconds (3,98 msec
per comparison, 3306 comparisons).
Top #1: 133(63,33%)
Top #2: 174(82,86%)
Top #3: 186(88,57%)
Top #5: 189(90,00%)
Top #10: 195(92,86%)
Top #20: 199(94,76%)

The number of comparisons between fingerprints of the same individual. For example, in
a database with 10 individuals and 3
annotated photos per individual, this number
will be 60 as each of the 30 fingerprint has
two possible matches.
For each comparison between two
fingerprints of the same individual, the found
ranking is added to a total. If the match
between two such fingerprints results in a
15h place in the total ranking, the total is
increased with 15.
This is the best score theoretically possible.
In the database with 10 individuals and three
fingerprints per individual, each of the 30
fingerprints ideally has its two other sibling
fingerprints ranked 1 and 2. In this case, the
ideal score would be 30x1 + 30x2 = 90.
Some statistics about the total number of
comparisons and the time required.
The top #X defines the number and
percentage of comparisons resulting in a
ranking in the top X of results.

The results of the evaluation are written to a file in the database directory (subdirectory
_SearchResults). The naming of the file is EvaluationResults__<date>_<time>.log.
Elaborate evaluation
Elaborate evaluation simulates a realistic scenario. After selecting this menu option, the window in
Figure 4-14 is shown. The user can select the number of iterations and the number of reference
images. Next, I3S basically separates the database in a reference set and a test set. From each
individual directory, the specified number of reference images is randomly selected and added to the
reference set. All remaining images are added to the test set. Next, each test image is compared
against the reference set. Statistics are kept about the number of times the right reference image
shows up in the top 1, 2, 3, 5, 10 and 20.
The output may look like:
Elaborate evaluation results
1000 repetitions, 1 reference image. #refs: 78
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Expert settings
NrElements: 50
WarpSize: 500.0
RelKeypointDist:
0.1
GrayConversion: [0.0,0.4,0.6]
MaxAllowedDist: 0.01
Filling the matrix: 515 seconds
Random iterations: 50 seconds
Top
Top
Top
Top
Top
Top

#1:
#2:
#3:
#5:
#10:
#20:

72963
76926
77773
79373
81051
81273

(85,84%)
(90,50%)
(91,50%)
(93,38%)
(95,35%)
(95,62%)

On this specific database of 163 turtle images, using 1reference image per turtle, gives 91,50%
probability that when comparing a new image of an individual already in the database, the proper
individual is found in the top 3.
More reference images will in general yield better results. However, more reference images will make
the set of remaining test images smaller, which could result in less significant experimental results.
Because the distinction between reference and test images is based on random selection, you need
to repeat the process a lot of times to average out any random effects. The iteration parameter
determines the number the process is repeated. The default value is 100. A 1000 iterations will
require more time, but because of a pre-processing step, 1000 iterations will require relatively little
more than the time needed for 100 iterations.

Figure 4-14: The elaborate evaluation window.

Evaluation of the database may be very time consuming. A good indication of the time required is the
time needed for a single comparison against the entire database x the number of fingerprints in the
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database. During processing you can change the amount of CPU power used by the evaluation
process by adjusting the slider towards ‘slow’ or ‘fast’. Faster evaluation might make other
applications less responsive.
Redo database
In case the algorithm to automatically extract the key points from the region of interest is changed,
this requires recalculation of all fingerprints in the database. Redo database will do this. See §6.6 for
an explanation why this might be needed. From each fingerprint in the database the reference points
and the region of interest are kept, only the key points are re-extracted. Before redoing key point
extraction the metadata.xml file is reread.
Redo individual
The key points are now only re-extracted for the current image and fingerprint.

Figure 4-15: The Help menu.

4.1.7 The Help menu


Open manual will start your default PDF reader and open this manual.



Check for updates… will check if there are updates. If an update is available you will be asked
only once to install at the next start-up of I3S, even if update checking is disabled. For successful
installation Windows User Account Control has to be turned off.



Go to the I3S website will open your default web browser and show the I3S website.



Video tutorials at the I3S YouTube channel will open your default web browser and shows the
start page of the I3S channel at YouTube.



About I3S… shows a window with information on version number, authors, copyright and contact
details.

4.2

The tool bar

Below the menu bar I3S shows a tool bar, which offers short cuts to functions described in the
previous paragraphs and some new functions. An overview of the tool bar is shown in Figure 4-16.

Figure 4-16: The tool bar.
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The table below describes the various items in detail.
Open file. Button for the menu option described in §4.1.1.
Save file. Button for the menu option described in §4.1.1.
Print file. Button for the menu option described in §4.1.1.
Search. Button for database search described in Chapter 5. A keyboard
shortcut is ALT+S.
,

,

or

Controls for zoom. Pressing the plus will zoom in on the image. If the
enlarged image does not fit the screen two sliders will appear. The
mouse wheel can also be used for zooming. The minus will zoom out.
The zoom factor is displayed right of the minus. The maximum allowed
zoom factor is 1000%.
Activate or de-activate edit mode. If yellow, editing is activated. If grey it
is not active.

or

Edit the information field. Each fingerprint file contains an information
field. Upon pressing the button, a metadata editor is opened (see §5.1 for
details). If the button is grey you need to activate the edit mode first.

or

Delete the region of interest and all key points inside. If the button is grey
you need to activate the edit mode first.

or

Change indicator. If the annotation has changed the button becomes
yellow until the fingerprint is saved.
A field, which will show instructions or the number of key points during
annotation. The field is larger in the application. If a message is shown,
the field will be yellow.

4.3

Pattern annotation

4.3.1 The reference points
For the algorithm it is essential to have a first indication how two images roughly match. For this step
the reference points are used. If the reference points are not annotated, I3S requires you to annotate
these first. Before you start, activate edit mode first ( ).
The reference points are annotated by clicking with the left mouse button the three reference points
in a fixed order. Do not mix-up these reference points as this will obstruct proper recognition! If you
click a wrong position you can undo this by clicking with the middle or right mouse button. The text
field will show in bright yellow which reference point to annotate. In the example in Figure 4-17 the
text field shows “Point out edge of outer scale as third reference point”.
You are entirely free to choose your own reference points. Give them proper names which make
sense and which are not easy to mistake for each other (names like ref1, ref2 and ref3 are not a
good idea). Further, the reference points should be clearly visible in all images and in an ideal case
they should form a triangle with 60 degree angles.
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For turtles, we chose the following reference points:
1. Beak edge.
2. Inner edge of eye area.
3. Edge of the outer scale.

Figure 4-17: Annotation of the last reference point with instructions
in the yellow text field. (Image source: PWF)

Figure 4-18 below shows these three points. The third requires some extra attention as for this point
sometimes there are multiple options. Pay special attention to consistent annotation of this reference
point.

Figure 4-18: The three reference points for a turtle. (Image source: PWF)
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4.3.2 Key point annotation
Next, you have to annotate the region of interest. This region is the area where the key points are
extracted automatically. Just click in the image and green lines will appear. You finish by clicking on
the start position. The polygon will be closed and the key points are extracted automatically (typically
in less than 1 second). During annotation of the region of interest, you can undo your latest action by
clicking the middle or right mouse button (or using CTRL-Z and CTRL-R). I3S will not allow selfintersecting regions of interest.

!

Automatic key point extraction is sensitive to visual circumstances such as murky water or
specular reflections. Hence, in some cases the extraction process may result in key points on
artefacts such as reflections. In these cases it is better to manually remove these key points. You
can do this by clicking with the right mouse button on the center of the key point. Obviously, if you
redo the automatic extraction, the unwanted key points will reappear.
Please be as accurate and consistent as possible in your annotation. Just because this is a partly
automatic process, this does not mean that the human is not vital. Any computer program, and I3S is
not an exception, works according to the principle of “garbage in  garbage out”.
You are also referred to the relevant tutorial on the I3S YouTube channel.
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5 Searching and using metadata
This chapter discusses the search process in more detail. First, the options to add metadata are
discussed. Next, the search process is described in detail.

5.1

Adding metadata

3

I S allows you to add metadata to an image. Metadata is additional information, which describes the
individual, location or perhaps the conditions in which the image was taken. If you press the
button
in the toolbar a new window pops up. The window is shown in Figure 5-1.
The upper text field allows you to store plain text. There is no limitation to its length. If no text has
been added yet, ‘Empty comment field’ is shown.
The Metadata elements field below allows for a more structured input. Four types of fields are
available: numeric, general size with three possible values (small, medium, large), Boolean (yes/no)
and custom. The latter is a finite user-defined set of values. The window below shows an example of
each type. The numeric field expects a number using the keyboard. Selecting a value from the
dropdown menu sets the other types. I3S allows you to include metadata elements in the search
process described below.

Figure 5-1: The metadata window.

The metadata fields are not fixed and can easily be edited by the user. The metadata structure is
defined in the file metadata.xml in the database directory but I3S provides a tool to edit the
metadata. For more information you are referred to §4.1.3.
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5.2

The search process

After selecting Search in database from the Database menu or pressing the search button
window will appear as shown in Figure 5-2.

, a new

Figure 5-2: Default search window.

By default all defined metadata elements are set to “don’t care”. You can also indicate how the
search process should act if an individual does not have a specific metadata element defined. By
default, the search will not fail on missing metadata.
If the search button is pressed, the current annotated photo will be compared against the entire
database without considering the metadata elements in the fingerprints. If the search takes more
than a second, a progress bar is shown.

Figure 5-3: Search window with metadata criteria.
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You can also search on specific metadata. The metadata structure is defined for the entire database
in the file metadata.xml in the top of the database directory. You can select per type of field the
appropriate constraints (e.g. equals, is less than, is greater than or don’t care). If you select the
default don’t care, that field will not affect the search process. If one or more metadata elements do
not satisfy the search constraints, the specific image is put at the end of the list of search results. If a
metadata element is not available (i.e. not yet annotated) the search process will ignore this specific
element and not exclude the image if you select “Match positive when metadata is unknown”.
Figure 5-3 shows the search window with specific constraints set for the metadata elements. In this
case, the search will only consider fingerprints with a left (or unknown) view, with sex ‘male’ or
unknown, size equal to “Medium” or “Large” or unknown, and a tail length smaller than 5 or unknown.

Figure 5-4: Search result window. (Image source: PWF)

When you click Search the Search result window shown in Figure 5-4 appears. Top left shows the
unknown individual. The right side of the window shows the ranked list of photos from the database,
10 at a time. With the vertical scroll bar you can scroll along the current set of 10. When the window
opens, the best ranked photos 1 to 10 are shown. The buttons Prev, Next and Start allow you to go
to the previous set of 10, next set of 10, or the first best 10. If currently matches 1 to 10 are shown,
next will show 11 through 20.
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Figure 5-5: Image (top) and key point cloud (bottom) pane. (Image source: PWF)
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By clicking one of the results in the list, the item turns yellow and the button Visual comparison
becomes clickable. When clicking it, a new window named “Compare results” will appear as shown in
Figure 5-5. The window contains four tab panes. The first shows both images together with the
annotated pattern and comments. The second and third tab pane shows the image of the unknown
animal and the selected animal from the results list respectively. The fourth tab shows the normalized
patterns in the same recognition space where the known fingerprint is transformed optimally to have
the best fit with the unknown fingerprint.
The first pane is equipped with a built-in magnifying glass. When you move the cursor over one of
the images the magnified part is shown to the right. Click with the left mouse button in the image to
lock or unlock the magnifying glass. When locked the symbol of a yellow lock is shown. Locking the
magnifying glass allows to compare two parts of the image in detail. By scrolling with the mouse
wheel you can change the amount of magnification.
The button
indicates whether AutoZoom is on or off. When yellow, AutoZoom is on. When ‘on’ the
visual comparison window will zoom in on the identification area. Figure 5-6 shows the difference.

Figure 5-6: With or without AutoZoom.

5.3

Actions after the search is completed

Based on the information in the ‘Compare results’ window you will ultimately decide whether the
individual is already known or unknown. You have four options how to proceed and four
corresponding buttons at the bottom of the window:
1. The individual is known and because the image is of good quality you want to add it to the
identification database as reference in future searches Press Include in database.
2. The individual is new and you want to add it to the identification database in a new individual
directory. Use the button New individual.
3. The individual is recognized but you do not want to add it to the identification database. You only
want to rename the image at the current location, e.g. in your own database. Use the button
Only identification.
4. You do not want to undertake any action. Press Close.
Figure 5-7 shows these buttons in more detail.
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Figure 5-7: The four other buttons at the bottom of the visual comparison window.

5.3.1 Include in database
Only add good quality images to the identification database. Poor quality images (e.g. large
deviations from a perpendicular viewing angle with respect to the animal) will lead to poor quality
search results. Ideally, aim at having about three reference images per individual in the identification
database. When clicking on the ‘Include in database’ button the following window will appear.

Figure 5-8: The 'Include in database' window.

By clicking the field Rename file you can also edit the filename. The fingerprint file will get the same
name, only with extension .fgp. We strongly advise to make sure that each filename contains the
identification number or name of the individual. After clicking Ok both the image and the fingerprint
file are copied (not moved) to the same directory as the matching image you selected. If you have
renamed the file, you will be asked whether you want to rename the original file as well.

5.3.2 New individual
If no matching individual was found you will probably assume it is not yet in the identification
database. To add it to the database, click on the appropriate button. The following window will
appear.

Figure 5-9: The 'New individual in database’ window.
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Fill in the name of the individual. This can be a name like ‘Gregory’ or just a number such as ‘Turtle
301’. This name will be the name of the new directory. In the next section you can choose to rename
the image and fingerprint file. We strongly advise to rename the file so it represents the identity. For
example, in case of Gregory you could name the file Gregory-12March2009Yap.jpg. After
clicking Ok both the image and the fingerprint file are copied (not moved) to the new directory in your
identification database you just specified. If you have renamed the file (which you should have), you
will be asked whether you want to rename the original file as well.

5.3.3 Only identification
If you have successfully identified an individual but do not want to include the image in the
identification database, you still might want to rename the file. In this case, press Only identification
and the following window will appear.

Figure 5-10: The 'Only identification window'.

Fill in the new name and make sure it ends with the proper extension (most likely .jpg) and press
Ok next. Both image and fingerprint file will be renamed.
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6 Some final thoughts on I3S
6.1

Recognition performance on turtles

Using the evaluation tool described in §4.1.6, I3S has been evaluated on a turtle database with data
from the Pacific Whale Foundation and HEPCA. The database consisted of 163 images. The output
of the test was:
# intra individual comparisons: 204
Accumulated ranking score:
1376
Best possible (ideal) score:
258
Top
Top
Top
Top
Top
Top

#1:
#2:
#3:
#5:
#10:
#20:

132
137
141
143
146
149

(85,71%)
(88,96%)
(91,56%)
(92,86%)
(94,81%)
(96,75%)

Thus, when offering a photo of an individual with one or more photos of the same individual in the
database, in 85,71% of the cases a proper match is shown as the first candidate, while in 94,81% of
the cases one or more matches are shown in the top 10.
Analysis of the poor matches indicates that angle is a leading cause. Below an example of a poor
match is shown where the image on the left is taken with a vertical angle while the example right is
taken with a considerable horizontal angle:

Figure 6-1: Example of a poor match caused by viewing angle. (Image source: HEPCA)
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6.2

Speed of I3S

3

I S can make use of the multiple cores available in all modern computer CPUs. If making full use of
multi-threading, I3S is about 2.5 times faster compared to only a single thread (on the computer used
for development, 2 cores). The options menu allows to set the maximum number of separate threads
for recognition (see §4.1.5). Experiments indicate that it is not useful to have more threads than twice
the number of processor cores/threads available to Java. By using all threads the computer may
become unresponsive to other applications.
On the development hardware (Intel Core i5 3320M @ 2.60GHz from 2013, DDR3 RAM @ 800
MHz), with 35 key points per individual, comparison time between two photos with various numbers
of threads is shown in the table below.
# threads
1
2
4
6
8

6.3

Time per
comparison
38,2 msec
22,9 msec
17,0 msec
15,8 msec
15,1 msec

Speed-up vs.
1 thread
1,0
1,7
2,2
2,4
2,5

Limitations of I3S

Although the family of I3S tools has been shown to work on a large number of species, there are
some limitations you should consider. Below we will discuss the two most important issues.
1. 2D vs. 3D. The main limitation is that a 2D model is used for a 3D animal. Especially with
increasing observation angles the limitations of the 2D approach become apparent.
Experiments on I3S Classic showed that accuracy deteriorates considerably with angles
larger than 40 degrees. For the moment we therefore advise to use photos taken from a
viewing angle smaller than 30 degrees whenever possible. This is particularly important for
the photos (to be) included in the identification database.
2. Linearity. We assume linearity of the animals. In plain English: we assume that the animals
are rigid and their body parts are always in the same position with respect to each other,
which is an optimal situation for comparison. Unfortunately, this is often not the case,
especially if (e.g. with small animals) the entire body is used for identification. Using the head
of animals has the advantage that you can safely assume linearity. The body is usually more
susceptible to deformations, and the tail part even more.

6.4

Data capture

We have the following suggestions when collecting photo or video data:
1. If you capture your subject, i.e. you take it out of its habitat to be photographed, please make
sure that:


There are no reflections from sunlight or flash. These reflections will disturb the
automatic extraction of key points. Try to shield your subject from direct exposure.



Take photos from the same angle, perpendicular to the identification area with all
reference points visible.
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If the entire body or a non-rigid area is used for identification, try to put your subject in
a construction or rig where the identification area is always in the same position.

2. Do not use direct flash as this will cause local highlights in your image, disturbing automatic
feature extraction. If flash is necessary, use indirect flash instead.
3. Do not reduce the resolution of the image. I3S will determine the proper resolution it needs.
However, it is usually a good idea to crop the image showing only the relevant part. For
example, Figure 6-2 shows the original photo at the left and a cropped version with only the
relevant part at the right. Annotation and comparing images will be much easier with the right
photo, while no information is lost provided you only crop and do not reduce resolution.
4. Try to get the viewing angle as close to perpendicular as possible. Analysis shows that most
mismatches are caused by deviations from the ideal viewing angle.
5. Consider using HD video instead of photography. The advantage of videography is that it is
possible to select the perfect frame.

Figure 6-2: Original photo (left) and cropped photo in the same resolution
showing only the relevant part (right). (Image source: PWF)

6.5

Is I3S right for your species?

The only way to find out is to set-up an experiment. Ideally, you have at least thirty individuals and for
each individual three or more photos of the same area of interest (e.g. right side of the head is
another area than the left side of the head of the same individual). If you have left and right side
photos of the same individual, make sure to put them in another directory, e.g. Turtle73_Left and
Turtle73_Right. Otherwise, the evaluation tool will count mismatches between right side photos and
left side photos incorrectly as errors (the evaluation tool does not consider the metadata!). Annotate
all usable photos, and evaluate the database using the evaluation tool (§4.1.6). If for example more
than 95% of photos of the same individual turn up in the top 5, you have a good indication it might
work for more data. Please do not hesitate to contact us at i3s [at] reijns.com to think along with you!
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6.6

Under the hood of I3S

Finally, we will discuss some internal variables of I3S. You can find these variables in file
metadata.xml (§3.3). You can change the values by editing the file manually, but a simpler way is
to use the expert mode while editing the metadata as described in §4.1.3. Changing these variables
may have a large (negative) impact on the performance of I3S.
The relevant part of the metadata file is shown below:
<!--

Advanced settings: do not alter without instruction or
really knowing what you are doing!!!! -->
<nrElements> 35 </nrElements>
<warpSize> 500.0 </warpSize>
<relKeypointDist> 0.05 </relKeypointDist>
<grayConversion> [0.1;0.6;0.3] </grayConversion>
<maxAllowedDistance> 0.01 </maxAllowedDistance>
<minRelativeDistance> 1.5 </minRelativeDistance>
<minRatioArea> 0.5 </minRatioArea>
Below we will discuss the variables. Six different variables are defined:
1. nrElements, an integer variable defining the number of key points to be extracted from the
region of interest. The default number (35) is optimized for turtles. Keep in mind: too few key
points is not distinctive enough. Too many may result in a computationally expensive
comparison, while increasing the possibility of a false positive match between two
fingerprints.
Changing this value requires automatic re-extraction of the entire database.
2. warpSize. Photos are taken from various distances and close ups will show more detail than
photos taken from a distance. The amount of detail influences the key point extraction. For
example, a sharp close-up with many small sharp features may result in many small key
points. However, these key points are not found in a photo of the same individual at a
distance, resulting in a poor match between the two photos. This variable resolves this. First,
the maximum distance is calculated between any two points in the region of interest. Next,
each image is scaled (normalized) such that the maximum distance becomes equal to this
variable. In this way all images are standardized to the same size and approximately the
same visible details.
Changing this value requires automatic re-extraction of the entire database.
3. relKeypointDist, a float variable which defines the required minimum distance between
two key points. In the default setting this is 5% of the maximum distance in the region of
interest. Each key point has a “response" which is an indicator for key point quality. After
extraction all key points are sorted, the key points with the highest response first. Next, for
each key point is verified whether it is too close to a stronger key point. If this is the case, the
key point is discarded. This variable is necessary to prevent areas with many key points. In
these cases, the recognition algorithm cannot make a reliable match.
Changing this value requires automatic re-extraction of the entire database.
4. grayConversion, a set of three weights with a sum of 1.0. The key points are not extracted
from a color image but a gray scale image. I3S converts the color image to a gray scale or
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intensity image by adding the values for the red green and blue channel where each channel
is multiplied by its corresponding weight. The sum of all three weights should be 1.0.
For example a pixel with RGB values [100, 200, 160] and RGB weights {0.2;0.5;0.3] will
result in a gray pixel value of 0.2x100 + 0.5x200 + 0.3x160 = 20 + 100 + 48 = 168.
This setting is useful when processing specific types of photo settings. For example, under
water red light diminishes quickest. On the other hand, if your animal has very distinctive red
spots, you might try to only use the red channel. Experiments have shown that accuracy may
increase significantly when choosing the right conversion. Please e-mail us when you need
assistance.
Changing this value requires automatic re-extraction of the entire database.

!

If you change any value of the first four variables
nrElements, warpSize, relKeypointDist, or
grayConversion always redo the key point
extraction for the entire database (see § 4.1.6 how
to do this).
5. maxAllowedDistance, a floating point variable which defines the maximum SQUARED
distance between two matching spots relative to the maximum distance between any two
reference points. In this case, 0.01 (10% squared) means 10% of this distance! This variable
is used to prevent matches between spots which are too far apart.
6. minRelativeDistance, a floating point variable defining the minimum relative SQUARED
distance between the best and second best matching spot. When comparing two fingerprints,
i.e. two collections of spots, a spot from the first fingerprint might match with more than one
spot from the second fingerprint. Usually, this happens more often in areas crowded with
spots and this might result in a messy recognition. By demanding that the second best match
is at a minimum distance of the best match, these messy recognitions are prevented
improving the overall performance. xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
For example: the value is set to 1.5. Spot 1a (first fingerprint) matches with spot 2a and 2b
(second fingerprint). The distance in recognition space between 1a and 2a is 9.5, and
between 1a and 2b it is 8.1. The best match is therefore (1a, 2b). However, the relative
distance between the two pairs is 9.5 / 8.1 = 1.173. Squared this distance is 1.376, which is
less than 1.5. Therefore the match between 1a and 2b is discarded.
7. minRatioArea, a floating point variable defining the minimum relative difference in size of
two matching key points. Each key point is a circle with a size. In recognition space, the two
fingerprints are corrected for scale variations. Nevertheless, it is not likely that two key points
are exactly equal in size. Far from that, the automatic key point extraction is often quite
accurate in the location, but circle sizes have a significant variation. This variable sets a limit
to the difference in circle size which is allowed.
For example: the value is set to 0.5. Key point 1 has a radius of 5, key point 2 has a radius of
4. The area of a circle = π * radius * radius, consequently the areas for key point 1 and 2 are
78.5 and 50.3 respectively. The relative difference in size is therefore 50.3 / 78.5 = 0.64.
Because 0.64 > 0.5 the size difference is acceptable.

42

